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Autodesk Inventor 3D CAD software has been the Autodesk flagship product for Digital Prototyping. Industries across
the globe have been using Autodesk Inventor to create their designs and produce new digital prototypes. Over the
recent years, productivity has been the key factor for any industry to get their designs or products to market faster. The
emphasis on productivity often requires engineers and designers to work under great pressure. Come to this class to
leam Autodesk Inventor tips and tricks to enhance your productivity and work with ease.

MA2822

Learning Objectives
At the end of this class, you will be able to:
Learning Objective 1: Be more productive while using Inventor
Learning Objective 2: Employ productivity-enhancing techniques while using Inventor

Learning Objective 3: Customize Inventor
Learning Objective 4: Use hidden capabilities in Inventor

About the Speaker
Sunith, after completing his Master's Degree in CAD/CAM started teaching AutoCAD and
Autodesk Inventor for more than 10 years both online and at training locations across India.
He's popularly known as CADProfessor & blogs at www.cadprofessor.in one of the highest
rated blogs. He has taught more than 10,000 students, faculty and Industry Professionals till
date on various CAD topics. His articles have reached AUGI Hot News, AUGI World Magazine,
AUGI ATP, Autodesk Community India, AUGI India, number of reseller newsletters across the
world. He has been teaching since 2003 on how to increase productivity in using CAD Tools.
He is a faculty member at M.S. Ramaiah Institute of Technology, Bangalore and currently
teaching various products of Autodesk to both undergraduate and post graduate students. He
is one of the first Autodesk Certified Instructor & Autodesk Certified Evaluator from India and
has conducted ACI Programs at India & Middle East.

sunithbabu@-cadprofessor.in

Autodesk Inventor Blog - http://goo.gl/ROBrRp

AutoCAD Blog - http://goo.al/pSRs3k

AutoCAD & Autodesk Inventor Tips Blog - http://goo.gl/seJ3Uu

Twitter: @CADProfessor
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Introduction

Autodesk Inventor is the foundation tool for Digital Prototyping. Every year Autodesk
releases new version of Inventor which provides newer ways to solve a project sometimes,
companies don’t move ahead with subscription which can result in decreased productivity
of the designers. As a result company loses the appropriate workflow needed for a
particular project.

The class MA2822 showcases tips and techniques available in Autodesk Inventor and
enables a user to learn different ways to be productive when working with Autodesk
Inventor and also be more competitive, some tips exclusively available for Subscription
Customers are showcased making a user / company understand the benefit of subscription.

Note: This hand out gives an exhaustive information on how to achieve productivity step by
step.



Autodesk Inventor User Interface Tips

1) Units / Template type
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Units in the earlier version of Inventor could be changed only after entering into sketch / part /
assembly environment. However this stands into effect only after restarting inventor. However this
is now overcome by introducing Units in the Welcome Screen. A nice and quick way to change the

units.
mi_5a_018.ipt
Tue 12
Configure Default Template
 Display at Startup
Access Default Template from Welcome Screen
2) Windows taskbar

A user can open the recently created / opened files
from Autodesk Inventor right from the Taskbar by
Clicking and moving in the upward direction. There
by helping a user save time in opening the model

? >

Pinned
[ mi08s 123 < —
Recent
mi_12a_D01
Partl
mi_2a_004
mi_5a_028
ri_5a_018 h
mi_11a_001
mi_08a_122
mi_DB8a_128
mi_2a_194
Partb
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I Autodesk Inventor Professional 2014 - English
o Unpin this program from taskbar
E3 Close window
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3) Mini Toolbar customization

Mini Toolbar helps users to quickly make changes / inputs for a particular command. This has two
options Pin Mini-toolbar position / Autofade

Note: This can be placed at Top Left Corner of the Graphics User Interface and also use the auto fade
option if needed.

gI @ i Loft B Coil ] Chamfer

S Emb Shell

D Sweep W Emboss | et =

[&s Rib [ Derive (%% Draft

| Create = Mo
| 2

=)

Extrude| Revolve

;Hv [
O~ | &~ |
v [ Ex

Pin Mini-Toolbar Position

Auto Fade

Mini Toolbar Option in Autodesk Inventor

4) Quick Access Toolbar

The Quick Access Toolbar (QAT) at the top of the screen displays commands across all
environments. It includes frequently used commands, such as Undo and Redo.

You can add any number of commands to the QAT. For this class MA2822, since I use frequently
Application Options. I can place the command in the QAT.

vﬁ u Default

Quick Access Toolbar with Application Options
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5) Working with Sticky Panels in Inventor

Sticky Panels are subset of panels found in the ribbon. Any panel within the Inventor tabs can be
made as a sticky panel by dragging them away from the Ribbon and placing them in the GUI. The
main advantage is that the commands within the panel can be accessed quickly rather than moving
the cursor to the panel location. These Sticky panels appear to be present on the screen when other
tabs are selected in Inventor. Making them accessible always.

ect Tools CAM  Manage View Environments BIM @ GetStarted Add-lns  Vault Vault Autodesk 3
i‘[ @ G Loft E Coil ‘ @ Chamfer % Thread 5&. Move Face E:E Rectangular
Sweep R4 Emboss il Shell Split (4 Copy Object Circular
Etrude Revoive @ =P & Hole Filet & & s & Copy Object | &
& Rib [ Derive (& Draft '/ Combine . Move Bodies | [ij§] Mirror
Create = Modify = Pattern ‘
Sticky Panels
Sl e FRE Tl Generic ~\&) [ Default
pect Tools CAM  Manage View  Environments BIM  GetStarted Add-Ins  Vault Vault  Autoc
GT ‘;a'“‘ igLlet B Coll T2 Rectangular @ & Thicken/Offset ] Patch
o e @ Sweep 1 & Emboss @ Circular S [{l Stitch bg Trim
l [Bs Rib  [ZA Derive | D ' @ 7] Chamfer 5 Thread -8 Move Fag, Delete Face
Create ~ Shell =4 Split 1 Copls Object
| S ot et iD Shcentur g Spi i) —OFy SO
@ Draft @ Combine D+ Move Bodies
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Sticky Panel for Modify is being created
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B [=]
Heate Fillet @ Drraft @ Combine G&' Move Bodies =
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6) Function Hotkeys in Inventor 2014

F1- Help F6 - Home View

F2 - Pan F7 - Slice Graphics in sketch mode
F3 -Zoom F8 - Show All Constraints

F4 - Orbit Alt + F8 - Open Macros Dialogue Box

F5 - Previous View | F9 - Hide All Constraints

Shift F5 - Next View | F10 - Alt + Tab

More shortcuts - Click Here

7) Inventor TEAM WEB

Specifies the location and name of the default URL or file launched by Team Web. Configure Team
Web to launch the default learning resource of your choice. Access Team Web from Getting Started
» Launch panel » Team Web.

%PUBLICDOCUMENTS%\Autodesk\Inventor 2014\Web\ CustomHelpSample.htm

The above file location can be replaced by web URL of your choice or intranet location within a
company

Link can be changed from Application Options » File » Team Web
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Notebook | Sketch | Pat | iFeate | Assembly | ContentCenter
General | Save | File | Colors | Display | Hardware | Prompts | Drawing

Undo
| 94 USERPROFILE % \AppDataiLocal iTemp),

Default templates
| ‘Configure Default Template... |
| 24PUBLICDOCUMENTS %\Autodesk Tnventor 2014\ Templates),

Design Data (Styles, etc.)
| BLPUBLICDOCUMENTS % \Autodesk\Inventor 2014\Design Data),

Default Content Center files

| 2GUSERPROFILE%: \Documents \Inventor \Content Center Files'\R 20144

Projects folder
| 94 USERPROFILE % \Documents Inventor,

Default VBA project
| SGPUBLICDOCUMENTS %t dutodesk \Inventor 2014\ Default.ivb

Team WEB

2ePUBLICDOCUMENTS 36 \Autodesk\Inventor 20 14Web\CustomHelpSample, htm

File Open
ie oo g

Quick File Open

Enable Quick Filz Open
(@) Cache the last opened assembly file
(") Cache files of the selected assembly

[i] (ot |v|| Egort.. || ok || cencel |

Team Web Customization



60 Autodesk® Inventor® Tips in 60 Minutes

Different ways by which you can access TEAM WEB
1) Getting Started Tab >

Codc-=s8 Tools CAM  Add-Ins  Vault

N 8 A 9

Mew Open Projects Open Welcome [Team Web What's : : :
Samples Mew || Overview Funda.. Create.. :‘

Launch | Mlew Featuresi Yideos and Tutorials

2) Access Help from Top Right Corner of Inventor Screen >

Type a keyword or phrase

L\T,_' Help Topics
Vault Help
| Team Web |

What's New
L ee—

Learning Tools F

Support 4

Community Resources b
Custorner Involvemnent Program
Download Language Packs

About Autodesk Inventor Professional

3) Access from Welcome Screen

Interactive Tutorials
) Create a 3D Model
i ded tutorial to create a
pe

Create a 3D Water Bottle
D
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8) Access Help within Autodesk Inventor (User Interface)

If your organization does not allow access to internet or you work with Inventor on the go and want
to access Inventor 2014 help then it becomes really difficult. Here is a simple tip to access Inventor
2014 help within your hard drive (393 Mb file)

Link -

English Autodesk Inventor 2014
[ Help Installer (exe - 402147Kb)

29 Help Install Instructions (html - 22Kb)

English Autodesk Inventor 2014

1.

Ui W N

Access C:\Program Files\Autodesk\Inventor 2014\Bin\helpids.xml and ensure the
UseOnline value is set to ‘1’ as follows: UseOnline="1". If the value is set to ‘0’, change the
value to ‘1.

Run regedit.exe

Access HKEY_LOCAL_MACHINE\SOFTWARE\Autodesk\Inventor\RegistryVersion18.0
Double-click EnableOnlineHelp

Change the Value Data field to 0.

<URL

rtrset}nline=”'_-" | b Chﬂﬂg& to Zero

Redirect="REDIRECT "

CnlinePrefix="http://"
OnlineWIEKI="wikihelp.autodesk.com/ ?adskContextId="
OnlineSearchWIEKI ="wikihelp.autodesk.comn/=search?g="
CnlineSuffix="famp;language=&amp; release=&amp;product="

OfflinePrefix="file:// /™
O0fflineHelp="Local Helpicontexthelph™
ErrorPage="Local I—!E'_-p‘xI—lE.-'_P_INFDRI{?-aT_'ZG?-I”
OfflineSuffix=".htm"

i

9) Add-In Manager in Autodesk Inventor

The Add-Ins button opens an Add-In Manager dialog box that lets you select the add-ins you want

to load or unload when Inventor starts up. You can access this tool by choosing Start > All

9
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Programs > Autodesk > Autodesk Inventor 2014 > Tools or, when in Inventor, by selecting the
Tools tab and clicking the Add-Ins button found on the Options panel. Once the Add-In Manager
dialog box is open, click the add-in in the Available Add-Ins area, and at the bottom of the dialog box
under Load Behavior, deselect the Loaded/Unloaded option to unload it.

Note: If there are add-ins you know you do not use, you can use the Add-In Manager to prevent
them from loading when Inventor loads. This will slightly speed up the load time (and reduce the
amount of RAM Inventor uses). Be sure you understand what specific add-ins do, because some are
required for the proper operation of the software.

Ppplications | Translators

Available Add-Ins /| Load Behavior | A

Azzembly Bonus Tools

Auto Limits

EIM Exchange

BIM Simplify

Contert Certer

Design Accelerator

Drag & Crop Interoperability
Eco Materials Adviser

ESKD Support

Feature Recognition

Frame Generator

iCopy

iLogic

Inventor HSM

Inventor Studio

Inventor Vauk

Mald Design

Routed Systems: Cable & Hamess
Routed Systems: Tube & Pipe
Simulation CFD 360 2014
Simulation: Dynamic Simulation
Simulation: Frame Analysis
Simulation: Mechanical
Simulation: Stress Analysis
Suite Worldlows: to 3ds Max
Suite Wordlows: to Showcase
Swift Prints

TEDCF Publishing Training

Automatic / Assemblies

Automatic / Pars
Automatic / Pars
Autormatic / Immediately
Automatic / Parts
Automatic / Pars
Automatic / Immediately

Automatic / Immediately
Automatic / Parts
Automatic / Assemblies
Automatic / Immediately
Automatic / Immediately
Automatic / Parts
Autormatic / Immediately
Automatic / Pars
Automatic / Parts
Automatic / Pars
Automatic / Immediately
Automatic / Assemblies
Automatic / Assemblies
Automatic / Immediately
Automatic / Parts
Autormatic / Immediately
Automatic / Immediately
Automatic / Drawings
Automatic / Immediatehy

Description

AddIn that provides Productivity
Tools in the Assembly environment

Location

Load Behavior

I™ LoadedfUnloaded

¥ Load Automatically

@)

Ci'\Program Files\Autodesk\Inventor 2014\8in\AssemblyBonusTools., dil

]

Add-In Manager in Inventor

10
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10) Using a Wheel Mouse and 3D-Input Device (Tip published at Cadalyst)

Wheel mouse in Inventor is recommended and this helps in controlling the PAN and ZOOM
Scrolling the wheel will perform a Zoom In/Out, while pressing the wheel will perform the Pan
function. In Inventor, the wheel zoom is reversed from AutoCAD. You can change this setting by
clicking Application Options on the Tools tab, selecting the Display tab, and selecting Reverse
Direction in the 3D Navigation group.

Customize the Navigation Bar

The navigation bar sits below the View cube in the upper right portion of the graphical canvas. By
default, it has quite a few commands that are not really needed if you are using your mouse every
day. Commands like the Steering Wheel, Zoom All, Pan, and Orbit are not terribly useful unless you
travel with a laptop and forget the mouse.

Typically, users can use the mouse center wheel for Zoom (scroll) and Zoom All (double-
click it), and for zoom either use a 3Dconnexion mouse or pull out a keyboard trick and hold Shift
while holding the middle mouse button. This leaves the Navigation bar pretty useless. The little
arrow at the bottom of the bar allows customization of the commands. Here a user can have
Projection and Visual Styles provided a user works in technical publications as well as PowerPoint.

: =)
Default | *- Proposed |

hd

Note: Adding commands to Navigation bar below view cube is presently not supported. If available
can further increase productivity.

11
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11) Opacity Control of View Cube:

Opacity Control of View Cube provides clear work space with the CAD model in Part / Assembly
/ Drawing environment and a user can avoid panning. With Opacity set to 0% additional
workspace of 10% is obtained when viewing a model within Autodesk Inventor.

Application Options
Show the ViewCube on window create
(@) All 30 Views

() only in Current View

Display
Top Right w | On-5Screen Position
Automatic W | ViewCube Size
0% » | Inactive Opacity

View Cube Opacity Control

ViewCube [active)

= |

SteeringWheels

[£] «

Pan

Zoom

Orbit

Look At Page Up
Zoom All Hame
Zoom Window Z
Zoom Selected End

[<]<]<]

= |

Previous View F5

Mext View Shift+F3

|

Projection 5
Visual Styles

[<]<]

Ground Plane

: Docking positions L4

EI 0% |_ :.i.nacti\re upar.lty LS |
25% Active cpacity »
30%
75%
100%

Inactive Opacity - 0%

12
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Sketching:

12) Load Sketching in Autodesk Inventor 2014

You can open Inventor Sketching Environment when you load Autodesk Inventor there by reducing
time and increasing productivity when working with Autodesk Inventor. Open Application Options
> General > Startup > Startup action > New from Template
“%PUBLICDOCUMENTS%)\Autodesk\Inventor 2014\ Templates\Standard.ipt”

Note: The *.ipt file units depends on the type of template we select.

Motebook Sketch Part iFeatu
General Save File Colors Displi
Startup

Startup action %

() File Open dialog
(I File New dialog
(®) Mew from template
9%PUBLICDOCUMENTS % \Autodesk\iny | [ 2]
Project file:

Default.ipj vy
Show Welcome Screen on Startup
Startup Selection of template (Sketching)

General Save File Colors |
Motebook Sketch Part iF

Sketch on new part creation
(I Mo new sketch

(@) Sketch on x-y plane

(1 sketch on vz plane

(i sketch on x-z plane

Select Sketching on X-Y Plane

13
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13) Command Prompting in Inventor 2014
Similar to AutoCAD, Inventor also has a Prompting Interaction which helps a user to

e Show Command Prompting ( Dynamic Prompts )
e Show Command Alias input dialogue
e Show autocomplete for command alias input

Prompting interaction
Show command prompting (Dynamic Prompts)

Show command alias input dialog

Show autocomplete for command alias input

Command Prompting in Application Options

® X

<Center Point Arc>
<Center Point Circle =
<General Dimension =
<Extrude =

<Fillet>

<Hole >

<Vertical =

<Line>

<Measure =
<Offset=

<Revolve =

<Mew Sketch
<Text>

<Trim >

<Zoom Window =

N*X 4wmog=E2Zr-r—=ITMoO®>

Command Prompting in Sketching Environment

14



14) Autodesk Inventor White Background

Solid white back ground in Inventor can
always be used because it allows a user to
take quick screen captures for use in
illustrations for a variety of publications
(examples:  how to videos, company
standards documentation, build
procedures, catalogs, and so on). However
this poses a problem where the projected
geometry appear as yellow and working
with yellow lines on a white background
makes these projected sketch lines difficult

to see.
Application Dptions

Matebook
General

Drafting

Additionally, if you use Inventor
during presentation
training, the white background
used in the Presentation color

Save

a or

scheme often shows up best, but
again the yellow projected lines
makes it difficult to work with,

particularly with some

projectors.

Rather than changing the

projected line color used in the Color scheme

Presentation color scheme, you Deep Blue
High Contrast

can use one of the other color Millernim
schemes, and use a solid white
background image. To do so, go
to the Tools tab > Application
Options button > Colors tab,

and then change the

‘Winter Day
wionderland

Presentation ‘

60 Autodesk® Inventor® Tips in 60 Minutes

Projected Sketch

®
Sketch
File

Part
Colars

iFeature Assembly Content Center

Display Hardware Prompts Drawing

Eackground

Background Image

File: narme:

Elank Wwhite. jpg

Changing background images

Background setting to Background Image. Then use the browse button for the File Name setting
to browse out and select a previously saved image file.

A user can select Sky color scheme (it uses green 1
called Blank White.jpg. I created the file called Bla
the Inventor Backgrounds directory.

ines for the projected geometry color), with a file
nk White.jpg using Microsoft Paint and saved it to

15
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D)
—
]
)
D)
n)
D)}

B = N S, 2

Better appearance

Yellow Line that comes because of Projected Geometry - to change this, use presentation with
White Background (Save as Image - png) and use Sky as option and then change it to
background option.

15) Sketch Doctor: (Sketching)
Sketch Doctor in Autodesk Inventor helps users rectify sketch related issues. When a user selects
sketch doctor by Right Clicking in sketching interface, the sketch doctor dialogue box opens. It is

divided into three segments Select > Examine > Treat

Select: This helps a user to select the sketch and diagnose a sketch to check for redundant points,
missing coincident constraints, overlapping curves, open loops and self-intersecting curves.

Examine: This helps a user to identify the type of problem that exists in sketching and provides a
possible solution to rectify the same.

Treat: This helps a user to close the open loop sketch or solving the error within the sketching
environment.

16
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'j? | Sketch Doctor

Select a problem to recover:

Select

@ < Back Mext = Cancel

Diagnostic Tests:

Redundant paints
Missing coincident constraints

COwerlapping curves
Self4intersecting loops

Sketch Doctor Selection Process

Select a problem to recover:

-] sketch1

Identification of Problem

17
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Problem diagnosis/description:

Open loop found in this profile. Use Close Loop or use Edit
Sketch and project geometry, add sketch geometry, and/for
drag the loop endpoints to dose the loop.

Examination of Problem

Select a treatment:

Edit Sketch

MNext =

Treating of problem identified

16) Creating an Offset Workplane and Sketch

The ability to create an offset work plane and sketch at the same time is something a quick process.
Conventionally we create a plane later offset the plane and then use sketching tool to sketch on that

plane.

The above tip can be executed by selecting one of the Origin Planes from the browser bar (active -
visible) followed by pulling the plane after selecting sketch command to required distance.

18



17) Slots

You can sketch linear or arched slots with a single command, similarly as other basic shapes like

rectangles or circles.

60 Autodesk® Inventor® Tips in 60 Minutes

-r;- Wiew: Master

= [ Origin

¥Z Plane

%y pl, ¢ Repeat Undo

[ 1% i [ copy ctrl+C
LY &% (22 New sketch

[17 a6 e >

& Centiammes:
Create Note
B [ Extrusiofm— =

| O endorrlatsbity |
o 7

Auto-Resize
(B}, Find in Window End
How To...

Sketch Plane Selection

==y
CAFYI=

iy

W

Moving the Sketch Plane from the Origin Plane (X-Y)

19
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Five new Slot commands are available:

® Center to Center Slot command creates a linear slot defined by orientation and length of
the slot centerline, and by slot width.

Bl4.0 mm

® Overall Slot command creates a linear slot defined by slot orientation, length, and width.

® Center Point Slot command creates a linear slot defined by the slot center, orientation and
length of the slot centerline, and by slot width.

® Three Point Arc Slot command creates an arc slot defined by a three-point center arc, and
by slot width.

20
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® Center Point Arc Slot command creates an arc slot defined by a center point, two-point
center arc, and by slot width.

- e
& [160deg] a0 -

TNy e TR

18) Trim and Extend Control

Trim and Extend Command can be used in different way within Autodesk Inventor sketching
environment. Some are listed below

Ctrl Key: Selects Termination Lines for Trim or Extend Command
Shift Key: Holding the Shift Key toggles between Trim and Extend Command

Hold Left Mouse Button: When a user continuously holds the left mouse button the Dynamic
Trim or Extend is enabled until the mouse button is released.

Right Click: Command option to switch between Trim, Extend or Split

21



19) Fully Constrained Sketch
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As a professional user, you know that all your sketches should be fully constrained, but how many

times have you closed a sketch only to realize that you didn’t check the status bar. Now all you need
to do is look in the browser.

Sketch Status from TEDCF Publishing is a simple but powerful add-in that gives you more control

over your sketches.

Open a part or sheet metal part and all the sketches in the file are automatically renamed to show

their constraint status.

7| ¢

@

@ Boss.ipt

L?J— £3 Solid Bodies(1)

- T View: Master

-ﬂ— D Origin

= (P Extrasiorr————

— =] Sketch1-<F> 3

— (@] shell1
— [} Work Plane1

=l T

=25 Projected toop1
“— (D End of Part

Sketch Status

In the example above Sketch1 is fully constrained, and Sketch?2 is under-constrained.

If you know the importance of fully constraining all your sketches, you know how important this

add-in is. It's free, so there's no reason you shouldn't try it.

http://www.trainingtutorial.com/Sketch Status 2014.htm

22
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20) I CHECKIT ADD-IN

There are several add-ins available that check to ensure that users have not forgotten to fill out
required iProperties. One such add-in is i CHECK IT from Tata Technologies. i CHECK IT goes far
beyond just checking iProperties, however; it will also check to ensure that the file naming
convention has been followed, that the first sketch of a model is constrained to the origin, that all
sketches are fully constrained, that only approved dimension styles are used, and much more.
There are over 100 checks that can be defined. To know more download from Apps Store

This app checks Sketching / Drawing Environment Files

http://apps.exchange.autodesk.com /INVNTOR/Home/Index

You get a > 30-day free trial version.

Part Modeling:

21) Fillet Success:

In previous releases, if one edge in a fillet selection set failed, the entire fillet operation failed. In
this release, any blend failures open a dialog box with the option to fillet the successful edges. After
you fillet the initial edge selection, you can repeat the operation using the same size radius. This

action usually blends more edges.

In the model used in the following image, an additional 17 edges are filleted after the first 142
edges are successfully filleted.

23
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Create Fillet

24 of the 166 selected edges cannot be blended at the current
size.

(V] Accept successful blends

If you attempt to place multiple fillets at once, you might be alerted to the fact that some of the
edges could not be blended successfully using the current radius size, in which case you can choose
to place the successful fillets and skip the others.

One of the most common issues with edge fillets arises when you select multiple edges that
converge

On a single corner vertex. Unfortunately, when this happens, the error message might erroneously
indicate an issue with the fillet size. However, you can generally resolve this issue by removing one
or more of the competing edges from the selection, applying the fillet feature, and then applying
another fillet feature using the previously removed edge(s). Keep this in mind as you place edge
fillets, and remember that just because you can place multiple sizes of edge fillets all in one feature
doesn’t mean it’s always the best solution.

22) Changing the Units of a Part File

If you start a part file using the wrong template (inches instead of millimeters or millimeters
instead of inches), you can change the base units of the file by clicking the Document Settings icon
on the Tools tab of the Ribbon menu and selecting the Units tab. Changing the base units will
automatically convert parameters but will not override parameter inputs. For instance, if you enter
a value of 3 inches for a dimension and then change the units of the file to millimeters, the
dimension will show 76.2 mm; however, when you edit the dimension, you will see the original
value of 3 inches.

24
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23) 2D to 3D App in Autodesk Inventor

2D to 3D App was first made available from Autodesk Labs and provides a great help in converting
legacy 2D AutoCAD files into native Inventor 3D models.

| 2 Dimensicnal Drawings |

I

| Extrude Front View |

1

Carry out Boolean
Operations of Side &
Top view

I

an Emors

R > S [ P
Model P
| Final Model |

1

Convert to STL or
Meutral CAD Format

Flow chart for 2D to 3D conversion

i}mmrmmmm*

1] Salct the shatch sagments
W Goometry  T1T] that define the base view

@ Lo | ewad |

Select

Conversion from 2D to 3D Stage 1

25
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To next

Orthographic View '

Intersect

Conversion from 2D to 3D Stage 2

24) Feature Recognition

Feature Recognition is a tool that converts neutral 3D CAD models, such as STEP, SAT, or IGES
solids, into full-featured Autodesk® Inventor® models. Feature mapping could be executed
automatically or interactively as needed to maintain design intent.

For more details visit the link below to download the Feature Recognition App - Click Here

SAT Model with Chamfer and 5 Holes
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Feature Recognition KF

\ ?) Do you want Eo recognize Features?

Yes Mo I Help:

Recognize Features

Automatic Feature Recognition
= : S =
_ﬂ Extrusions Facel -
Face2
M revaolutions e
B Holes Faced
[ Fillets FaceS =
[ chamfers Faref
Sculpts Face?
= Fared =]
[ Select Al Selecthl | cearmt |

Types of Features to Recognize
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s [T work Plane1
- (P Extrusion
i1~ (i) Holes

[+ [ Holed

Feature Recognition =
@ Recognized Features
— ﬂT Exkrusionl
—
B
-
Repeat Undo i

— [ T _
= @ Hale Recognize Pattern Circular
= @ Cha
= @ Cha

[eleke Rectangular

&} Find in Window End

Help Topics. ..

Combine holes to make rectangular pattern
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25) Printing your 3D Models from Autodesk Inventor 2014.

Autodesk Inventor now has option to print your 3D CAD models by converting it into STL Files

and later you can upload them into Autodesk Recommended 3D printing companies.

Set up an account
Upload your STL file
Request a cost estimate
Place your order

Pay for your order

The orders vary from $15 - $25 per cubic
inch

Note: Additional tips related to 3D printing
are provided here -

http://images.autodesk.com/adsk/files/tips f
or _optimizing your model.pdf

http://usa.autodesk.com/adsk/servlet/pc/ite
m?id=22025960&sitelD=123112

26) How to convert iPart to a Standard Part

Search Commands

Vault
Server
Suite

ZD Workflow
s

iProperties
=

Print

(=] Print
Select a printer and other printing

options before printing.

Print Preview
I:él Preview and make changes to pages

before printing,

Print Setup
@ Select a printer and other printing
options without printing.

Send to 3D Print Service
@ Prepare files and post to 30 print

SEVice,

»

) eo

ﬂ Close

Efj 3D Print Preview

Preview models before printing.

| Options | | Exit Autodesk Inventor Professional

You can convert an iPart to a standard part file by right-clicking the table in the Model browser
and choosing Delete. The part will assume the active members’ feature values and states.
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g Threaded_Stud
e iﬁ Table
£ solid 1)
"_'3'- View: Master
] origin
(P Extrusion1
L[] sketch1
@ Chamfer1
Hole 1
- [Ig mirror1

O End of Part

i £

When Table is deleted will convert iPart into an Active Part

27) Part Model Simplification: (Building Information Modeling - Ready)

In addition to the tools available to simplify assembly models, you can also use the BIM Feature
Recognition and Simplify tools in the parts environment to reduce details that are not needed for
BIM models, and you can use the Recognize Revit Features tools to make your models friendlier to
Autodesk Revit

Note: One of the issues with handling part models created in Inventor to the BIM user is that the
models often contain cosmetic or manufacturing features that are important in the mechanical
design, but are not required for the BIM layout and planning application. For example, if you create
a model of a machined part in Inventor, you will likely need to include and specify rounded edges,
holes, and other features as part of the mechanical design. However, these features are not
important to the BIM user and can slow down the BIM application. So to help with this, Inventor
includes part simplification tools to remove detail and voids, as well as reduce the number of faces
and edges in a part model.
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= | (RS (O Mipces selectable |
Fill Voids Define = : ‘
Envelopes | (@ '@ &4 '_@J} \_E Auto Select
5 ' ."'_ )
mplify v |+ x._,J 'g_',;]

) ()
I:ﬁ. Select Loop
9| Iz Select Edge

FE  Select Face

Remove

Details

Simplify

Fill Voids
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Remmre FII! Voids
Details

Simplify

Define Envelopes

28) Extruding Solids from Open Profiles

In addition to extruding surfaces from open profiles, you can extrude solids, provided sufficient
geometry is present to allow the open profile to solve correctly. This technique employs the Match
Shape option and is the default solution when an open profile is selected in the Extrude tool while
the solid output is selected

LY

3 J
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Assembly Modeling
29) Grounded Part

When we start Assembly Modeling and insert the first part they are not grounded in Inventor 2014
Version. So care must be taken to ensure you select grounded part from marking menu.

Another option is to input a permanent solutions by selecting from Application Options

General | Save | Fle | Colors | Display | Hardware | Prompts | Drawing
Notebook | Sketch | Pat | Featwe | Assembly | ContentCenter
[ pefer update

[ pelete component pattern source(s)

[]Enable relationship redundancy analysis

[ ]Enable related relationship faiure analysis

[ Features are initially adaptive

[]section all parts

[ ]Use last ocrurrence orientation for component placement
[ relationship audio notification

[ | Display component names after relationship names

Place and ground first component at origin
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30) Constraint Audio Notification

When two components / parts are assembled in the assembly environment with default settings,
we hear a sound (Tock) and this at times is annoying to users or when you do a corporate training /
presentation or trying to explain the sequence of assembly for a vendor. This can be overcome by
switching off the Relation Audio notification and enabling Display Component names after
relationship names

Application Options =

_ General Save File Calors Dizplay Hardware Prompts ['J'rawing
Notebook Sketch Part Feature Assembly Content Center
[ | Defer update

[ |Delete component pattern source(s)

[ Enable relationship redundancy analysis

[ |Enable related relationship failure analysis

[_|Features are initially adaptive

[ |5ection all parts

[ |Use last occurrence orientation for compaonent placement
@Relaﬁnnship audio notification

[#/|Display component names after relationship names

[ |Place and ground first component at origin

Note: By enabling the Display Component names after relationship names Autodesk Inventor
displays the component instance names with the relationship.

When the check box is cleared, Autodesk Inventor does not display the component instance names
with the relationship. For example, if constraint 12 is a Mate constraint between rod:1 and
cylinder:1, the browser displays:

‘f Mate:12(rod:1, cylinder:1) When option enabled

EF Mate:12 When option not enabled
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5 solid Bodies(1)

-_T- View: Master

El Crigin

m Extrusion 1 (Mew Solid x 10 mm)
L 7] sketch1

EﬂT Extrusion2 (Cut x 10 mm)

L [E| sketchz

@ End of Part

31) Free Move ( Assembly )

With the Free Move command, display relationships as an elastic band, and visualize and manage
relationships in a new way. Click a relationship icon, and then, to suppress, unsuppress, or delete
relationships, use the context menu.

35



60 Autodesk® Inventor® Tips in 60 Minutes

32) Assembly copy paste

Assembly copy paste

In previous releases of Inventor, a copy and paste operation did not retain component connections
or current orientation.

w

'8
&,

The enhanced copy and paste operation produces a duplicate of the copied components with
connections and orientation intact.
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33) Joints in Autodesk Inventor 2014

‘0
The Joint command is a simple way to position components and describe motion. Creating
a joint fully defines the component location and motion in one step. End, mid, and center
points are used to associatively position components. The geometry you select determines
the default joint type, or you can specify a joint type.

The following describes the joint types and how they operate while positioning a
component:

o

Removes all degrees of freedom (DOF). Welded and bolted connections are examples of a
rigid joint.

[:ﬂ:] Rotational

Specify one rotational DOF. Hinges and rotating levers are examples of a rotational joint.

]

s

i Slider
Specify one translational DOF. A slide block moving along a track is an example of a slider
joint.

TN
@ Cylindrical

Specify one translational and one rotational DOF. A shaft in a tube is an example of a
cylindrical joint.
£ planar
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Specify two translational and one rotational DOF perpendicular to the linear. To place a
component on a planar face, use this joint type. The component can slide or rotate on the
plane.

ad-o
”'_l'_'_';
g Ball

Specify three rotational DOF. A ball and socket are an example of a ball joint.

)
)
_, ]+ /
~/ | -

Note:

® With the addition of the joint command, both constraints and joints are now
described as relationships.

® In the browser, the Constraints folder is renamed to Relationships, and displays in
both the Assembly View and the Modeling View.

® You can use joints with constraints to position components and describe motion.

34) Express Mode for Large Assemblies

Express mode introduces a new way of working with large assemblies. Large assemblies
typically open 4-6x faster, dramatically improving your time to work.

Enable the Express option and set the unique files threshold in the Application Options,
Assembly tab. large assemblies that exceed the threshold open automatically in Express
mode.
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@ Load Full to exit Express mode and enable all commands.

Express Mode OFF in the above case

Express Mode ON in the above case
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35) Show and Hide Relationship Tools

In addition to locating constraints in the browser, you can use the Show Relationships tool to select
a component and locate all of the assembly relationships that involve it. Once the relationship
glyphs are shown, you can right-click any of them and choose from a number of options, such as
Edit, Delete, Suppress, and so on. You can then use the Hide Relationships tool to turn off the
display of the relationship glyphs in the graphics area.

If any assembly relationships contain errors, you can use the Show Sick Relationships tool to find
them quickly.

Mame/Parameter: Mate:25/d312
Partl: BS 4168 : Part 2 Hexagon socket screws and wrench keys,
metric series- Specification for hexagon set screws with flat point -

Metric M3 x 16:4

Part2: Arbor_Frame:1
Solution/Type: Mate/Mate
Offset: 0.000 mm

Show and Hide Relationship Tools
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36) Place Assembly Constraints Using Alt-Drag

Rather than using the Place Constraint dialog box, you can press and hold the Alt key and then drag
a component into position. Constraints are inferred based on the type of geometry selected. The
constraint is previewed in the graphics area as you drag over the components involved. To set a
specific constraint, release the Alt key and enter one of the following shortcut keys. You can press
the spacebar to flip the constraint solution, from Mate to Flush, for example.

€ M or 1 changes to a Mate constraint.

@ A or 2 changes to an Angle constraint.

@ T or 3 changes to a Tangent constraint.

@ | or 4 changes to an Insert constraint.

@ Ror 5 changes to a Rotation motion constraint.

@ S or 6 changes to a Translation motion (slide) constraint.

@ X or 8 changes to a Transitional constraint.

To see the Alt-drag method in action, select the Get Started tab, and click the Show Me Animations
button. Click the Assemblies - Constraints link in the list and then choose Alt-drag Shortcut
Animation from the next list.

37) Degree of Freedom Analysis
Degree of Freedom Analysis can be accessed from

(]
Ribbon: Assemble tab » Productivity panel » Degree of Freedom Analysis s

This command displays a dialog box that lists the number of translational and rotational degrees of
freedom for all the occurrences in the active assembly.

A dialog box displays a list of all first-level components in the active assembly with a count of
remaining degrees of translational and rotational freedom.
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Degrees of Freedam

Degree of Freedom Analysis

Productivity

38) Creating Mixed-Unit Formulas

You can mix any acceptable units in the same parameter formula and allow Inventor to do the
conversion. For instance, entering the following into a dimension is perfectly acceptable:

3.25ft-1m+3 cm+0.125in = 23.775 mm
This would return a value of 23.775 mm in a millimeter part.
39) Adjusting the Save Options

Inventor does not have an automatic save function, but instead has a save reminder utility that
allows you to save by just clicking within the bubble to launch a standard save operation. To adjust
the save timer settings, select the Application Options button and then select the Save tab.
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Application Options x|
Motebook Sketch Part iFeature Assembly Content Center
General Save File Colors Display Hardware Prompts Drawing

[ ]Prompt to save for re-computable updates
Prompt to save for migration
[ ] Do notlist referenced files that default to o™ in the Save dialog

Save Reminder Timer: 5 : minutes

Save Time Reminder

40) Migrating Templates to Autodesk Inventor 2014 Using Task Scheduler

Before migrating any templates, make sure you've backed everything up! I've never had a problems
with migration, but you only have to be wrong once!

To access Task Scheduler, go to Windows Start>All Programs>Autodesk Inventor 2014>Tools.
Task Scheduler will be in there.

41) Project File Version

Each time you save an Autodesk Inventor file, the previous version of the file is stored in an
OldVersions folder under the folder containing the file.

You can specify how many versions of each file are stored in the OldVersions folder.

Expand Options.

Select Old Versions To Keep On Save.

Click the Edit selected item button (on the right-hand portion of the dialog box).
Enter the number of versions to keep.

W N e
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Project name Praject lbcation 3
stednader Ci'\Users'Publc \Documents \Autodes: \Waut 201 1\5amples\Autaloader Irentor 2.,
Default Ci\Lisers'Publc \Douments\Autodesicdnventor 20104
Defanlt
Desigrs Cr\Lisers'Pubiic Documents\Autodesk Wault 201 1\Samplesirventar 201 1\Padiodk) -
Designs Ci'\Users'Public Deuments\Autodesk \ault 2011 \SamplesIrventor 2000\Padiodk)
iLogc 2011 Samples Ci\Users'Publc\Documents\Autodesinventor 201115amplesogic Samples|,
ilogic 2011 Tutorials Cr\UisersPublc\Dowuments\Autodesddmentor 20111 Tutorial Files Yogic Tutorials)
Invenbor_Teadher CriinventorTeschar |

e 1}
Ci Wserssunithbabu\Documents irven tor ProjeciName Mnventor

Frequently Used Subfolders
[ ) Folder Dptions
El () Options
E

T Shortout = Frojectiame 1

ab] Owner =

Al Relagse ID =

& Imported Components Foider Name = Imported Companents

Tl Imported Top Level Assembles Folder Mame = Imported Components
[# ) Vault Options

[ new |[ Browse... |

Once the specified number of saved versions is reached, subsequent saves eliminate the oldest
version.

0Old versions are formatted as follows:

@ First save of existing file = file name.0001.extension.
@® Second save of existing file = file name.0002.extension.
® Subsequent saves are named in a similar manner.

Mame Date modified Type Size

(1) Part2.0006 6/17/2010 10:14 PM  Autodesk Inventor... 76 KB
T ProjectMame.ipjbak 6/17/201010:12 PM  BAK File 6 KB

six times saved

You can open an older version of a file as a read-only file. Alternatively, you can restore an old
version as the current version of the file. Before the restoration of an old version, the file is saved as
the most recent version in the OldVersions folder.

42) Autodesk Remote

Autodesk Remote helps you connect your desktop / laptop inventor software - service to drive
Autodesk software installed on your primary computer from a remote PC or iPad® to access native
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design data. The iPad app, compatible only with Autodesk® Inventor® software, enables you to
work anywhere you can access the Internet. This service is available with purchase of Autodesk®
Subscription for select Autodesk products.

Watch the video to learn more about Autodesk Remote - Click Here

43) Autodesk Inventor - Getting Started /
First Time learner.

@ Help Topics
Learning map helps you build and track

l Vault Help
skills ! Team Web
| What's New
] |z| Shortcut/Alias Quick Reference
A First time inventor learner can get a | Getting Stared |. Learning Tools 4
complete learning experience by clicking Skt Puoldees B Shou G sladed Tal
on Access Help lcon > Learning Tools > o 1| et '
Community Resources 3

Getting Started

Customer Invalvernent Program

This provides a new and interesting Download Language Packs
learning portal within Autodesk.com site, About Autodesk Inventor Professional
which is structured and easy to understand

and learn.
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What is
Autodesk
Inventor?

5

| 1. Fundamentals | Presentations |}
| I \ J

| ; 4 Drawings |
L Environment i |

| 33D Modeling ||
|\ andDesign |

/ /
/

Specialized

Parts and
Assemblies
Assemblies

Link - http://akn.autodesk.com/maps/ENU/99994

Simplified Getting Started

44) Improved Graphics Performance

The following graphics enhancements improve the performance of pan, zoom, and rotate of large
models in both Full and Express mode.

The maximum frame rate is increased from 10 Hz to 20 Hz.

The largest objects are drawn first.

The graphics system now uses multiple cores to provide the best possible performance.

A new background operation called consolidation is added. Consolidation draws objects
that have the same appearance as a single group, improving the GPU usage.

In the following images, the 2013 model on the left displays the results of rotating the model using
the maximum of ten frames per second. Increasing the frame rate increases the speed, but the
choice of components to draw is not intelligent. The 2014 model on the right shows the results of
rotating at the faster maximum frame rate of 20 Hz. The model remains recognizable, and all view
operations are faster.
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Minimum frame rate (Hz)

45) Key Tips using ALT key

Keytips are shortcut keys for performing tasks without using your mouse. Using Keytips, you can
navigate in the Application Menu and the ribbon using only the keyboard. Use the keyboard arrows
to navigate to commands on the ribbon and Application menu.

Press ALT or F10 to display shortcut keys for common tools in the application window. Keytips
appear as underlined characters to indicate which key or combination of keys to press to activate a
command.

When you select a keytip, more keytips display for that tool.

W& app manager

Smfer hread "% MovEFRe I Rectangular | & Thicken/Offset =] P

3 = : fau Mch
5 Emb Shell =4 Split [ Copy Object Point - Circul Stitch T
Create | Box Extrude Revolve @ i q e Hole  Fillet 5 g ik IS RE Plane %o @ feh B] ¥4 %E s
2D Sketch " [B5 Rib [ Derive (@ Draft (] Combine @ Move Bodies e ucs [l Mirror & sculpt &, Delete F
Sketch Prim\trves| Create « Modify Waork Features Pattern Surface ~

46) Undo File Size

The Undo File Size is very essential when a user works with large assembly files. However, it is essential
to reduce the Undo File Size from 1024 MB to 256 MB so that the user gets the additional RAM to work
with Inventor 2014.

47



60 Autodesk® Inventor® Tips in 60 Minutes

The Undo File Size can be accessed from Tools > Application Options > General Tab

Autodesk recommends adjusting this in 4 MB increments.

1024 - Undo file size (MB)

1 ==| Annotation scale

Undo File Size

47) iPart Factories in Assemblies
You should be aware that Inventor does not allow an iPart factory file to be placed into an assembly.

If you attempt to do so, only a member of the factory will be placed instead. However, keep in mind
that if you create a regular part file, place it into an assembly, and then turn it into an iPart factory,
changing the factory table does not place a member file but simply updates the factory. Using
factory files in assemblies in this manner is not the intended workflow for iParts.

48) iFeatures Are Powerful Tools

These tools allow you to quickly create standard features in your models. Examples include o-ring
grooves, louvers, bosses, ribs, electrical connector punches, patterns of holes, and an infi nite
number of other features. Another major advantage of iFeatures is that they enforce standards.
Since the iFeature can be designed to allow the user to select predefined sizes only, the possibility
of error is greatly reduced. Take a few moments to examine your designs, and you’ll likely see many
opportunities for iFeatures.

49) RAM Requirements for Autodesk Inventor 2014

When it comes to RAM, the more your system has, the better it will handle large and complex
assemblies in Inventor. You can use the number of unique parts in your assemblies (unique parts as
opposed to multiple instances of the same part) as a general rule of thumb when determining how
much RAM to consider. Here is a list of recommendations based on unique part count:

€ More than 5,000 unique parts: 6 GB of RAM

€ More than 10,000 unique parts: 12 GB of RAM

48



60 Autodesk® Inventor® Tips in 60 Minutes

@ More than 15,000 unique parts: 18 GB of RAM

€ More than 20,000 unique parts: 24 GB of RAM

50) Memory Probe

Included in your install of Inventor is a utility designed to monitor memory use for your system.
The MemProbe utility, shown in Figure, looks at the Inventor process and displays its use of
physical and virtual memory. It can often be useful in troubleshooting issues of capacity and slow
performance. You can find this tool at the following location. You might find it useful to create a
desktop shortcut to it, if you find yourself using it often:

C:\Program Files\Autodesk\Inventor 2014\Bin\memprobe.exe

i 1 N
il [nventor - MemProbe |ﬂlﬂ—hj

Process Options  Yiew Help

Phyzical bMermaon

Hardware 4028 Wb
[nventar Wiorking Set 436 Mb
Avwailable 2260 Mb W
System "Working Set 33mb
Syztemn Mon Paged 142 Mb
Other Applications 1106 kb
Yirtual bMemany
Page Fil= Size 9434 b H
Fage File Jzed 4826 Mb
|rventor Page File Llzed 382 Mb
Total Hard Page Faultz 942 Bz
Total Soft Page Faults 17441/
|nventor Soft Page Faults 4155/
System Soft Faults 39/
Wirtual Query of [rventor
Carnrnitted 1137 Mb
Rezerved, not committed 524 Mb
Wasted 47 Wb
Free 3386899 MbH W
il ax Reserved Chunk, 209 Mb
b am Free Chunk E555733 Mhb
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51) Participate in CIP and CER

The Customer Involvement Program (CIP) aids in collecting information about your use of the
Inventor software. Customer error reporting (CER) aids in sending information to Autodesk when
the software program closes unexpectedly.

CIP Details:

To guide the direction of the Autodesk design software in the future, your use of the Inventor
software is forwarded to Autodesk if you participate in the CIP. You can access this feature by
selecting Help > Customer Involvement Program. In the Customer Involvement Program dialog

box, you can select a level of participation and then click the OK button. The following information
might be collected:

@ Autodesk product version and name
@ Inventor commands and time spent
@ Error conditions (catastrophic and nonfatal)

@ Information such as system configuration, IP address,

Autodesk Customer Involvement Program H

£ AUTODESK.

w

Join the Customer Involvement Program

To help improve this and other Aut ducts, you can partidpate in
ent Program d information to us about how

of the information collected is used to individually identify or contact
You may opt out of the program at any time through the Help menu.

uld like to participate in the Customer
ent Program.

@ Mo, I do not want to join the program at this time.

CIP Agreement
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CER Details:

Customer error reporting is a process by which Inventor users can report crashes to Autodesk. A
software crash happens when the software program closes unexpectedly. When you have an
unexpected error, Inventor shows a dialog box, and you can choose to send the error to Autodesk.
CER records the subset of the code that was in use before the crash. The CER report collects a
variety of information, such as the following:

@ Operating system and graphics driver name, version, and configuration
@ Autodesk software name and version

@ List of recently used Autodesk commands

@ Lines in the code where the crash happened

1. An unexpected

software problem accurs. Wow, a patch
The user is asked il he wants already. That
to send an error report: Immediste was quick!
Update
OK, | will send Thank you Motification

the error report. foryour
submission

Autodesk

3. If 2n update exists, it
is immediately sent
to the customer.

If not, customers are Hey, here’s the
automatically notified | patch for the
The Custamer Erfor when their errer is problem | submitted
Report is sent addressed in a future | last month.
to Autodesk 2. If there is no current update, Autodesk software update. e
will take the customer error report into _.':_f :
comsideration when building the next o

update or next major release. \
Delayed b
Update
Motification

CER

RPLANEIORSS by LALARLS
ETO08 TPLARE tom

CER Workflow

52) Autodesk 360

With your Autodesk® 360 account you can save files to the cloud. View and edit them using any
web browser or mobile device.

Storage

Receive 5 GB of free storage instantly simply by creating an account. Additional storage is available
with Autodesk® Subscription.
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Viewing
View and edit 2D and 3D design files through a web browser using Autodesk 360 or via a mobile
device using Autodesk® 360 or AutoCAD® WS mobile apps.

Collaboration and Sharing

Share files with your team. Invite them to view, markup, share, and download designs directly in a
web browser or mobile device. Follow user comments with the ongoing activity stream.

Rendering

Autodesk® 360 provides powerful cloud rendering capabilities that reduce time and costs by
enabling users to produce compelling, photorealistic visualizations without tying up the desktop or
requiring specialized rendering hardware.

PixIr

PixIr™ products are free* online and mobile image editing tools and utilities for creating, editing,
and sharing images.

Recap Photo Trial
Create 3D models from photos in the cloud with Autodesk® ReCap™ Photo Trial.

Fusion 360

® Autodesk® Fusion 360™ is the next-generation 3D design tool that seamlessly combines
industrial and mechanical design with collaboration in one easy-to-use and affordable
solution.

Mockup 360

® Autodesk® Mockup 360™ is a real-time collaboration and digital design mockup tool that
enables engineers and project managers in manufacturing environments to work with
suppliers and customers in a simple, cloud-based environment.

Configurator 360

® Autodesk® Configurator 360™ is a cloud-based service that helps custom product
manufacturers of all sizes deploy an online catalog of products with a built-in product
configurator.
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g |5_'—| Streamline
u o & Supplier Content

Launch sticn 3
Website gﬁ |dea5tation
Access Simulation Web

53) Increase Screen Space

The ribbon is designed to provide more available graphic space for your models.

Click the Minimize button once. The panels reduce to panel buttons.

Partl.ipt

Add-Ins Online

Get Started

] Minimize to Panel Butto

38 %

10 Index Attach Make Make Create O%
Part Cn:1m[;u'mt3nl:s| iPart v
j Point Cloud ‘ Layout ] Author |

Partl ipt

Get Started Add-Ins Online

P 0§ | &4 | &

Point Cloud Layout } Author iLogic *Contentc Web

[nsert

Pause the cursor over a panel to display the commands on that panel.

pols EELELEM View  Envionments — Get Started
_
S

iLogic |Content C...

E] Streamline
& Supplier Content

@) Team Web
j Web

Click the Minimize button again to reduce to the tab and panel titles.
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Hel Inspect Tools RMEEUELRCE View  Environme
dards | Insert | Author | iLogic | Content Center | Web -

= X

o

Click the Minimize button again to reduce to the tabs.

Click a tab title to reveal the tab.

odel Inspect Tools M.anaq«k View Enviro
ofe i
5,

f @? Insert Obje
xr

% Update
arameters | Styles Editor  ~ pda

f% Purge
arameters | Styles and Standards

|

Click the Minimize button again to restore the full ribbon.

| Insert

View Envionments Get Started @n

@9 Insert Object 52 Export Oects
ite iMate
Create o
B iAssembly
i Insert _ Author

As an alternative to cycling through the ribbon states, select a state from the drop-down menu.
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You can also use the Clean Screen command to maximize model space instantly.

54



60 Autodesk® Inventor® Tips in 60 Minutes

On the View tab, click Clean Screen.

r—- ] p— T ﬁ
FQ E o[ E
esign View User Gﬁ. Switch
resentations | Interface "| Scr N

wed Views | Windows

This command hides the browser and maximizes the graphics area to the application window. Tab
panels are minimized if they were in a maximized state. The command also maximizes the Autodesk
Inventor window to your screen.

B = TaRr BmOm

Sheet Metal 3D Model Inspect

You can also use the keyboard shortcut: press Ctrl 0 (zero) to switch from Clean Screen display. The
browser is restored and the tabs are also restored to whatever state they were in previously.

Click the Minimize button, as needed, to restore the tabs to their full display.
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55) End of Part

The End of Part Marker, or EOP sits at the end of Inventor’s feature browser to let us know that
there are no more features.

@ End of Part |

The End of Part Marker can be used as a productivity tool in its own right. Here are five great tips
for making use of the EOP.

Five EOP Productivity Tips.

There are five ways to use the EOP:

¢ You can step through the feature tree to see how the part was created.
¢ You can use the EOP to place features at the correct place in the tree.

¢ You can use the EOP to help repair broken features.

¢ You can delete all the features below the EOP.

¢ You can roll the EOP up to make the part file smaller.

56) Autodesk Inventor IdeaStation

The Autodesk Inventor IdeaStation can be accessed within the Software from Autodesk 360 tab »
Web panel » IdeaStation.

The Autodesk Inventor Idea Exchange is a forum dedicated to improving Autodesk Inventor
software by sharing your ideas for improving the product directly with the developers.

Do you have a great idea for a new feature or enhancement you’d like to see in Autodesk Inventor?
Share your wish list directly with the Autodesk Inventor Development Team, and let us turn your
ideas into reality.

Post your ideas, see what your peers are thinking, and give kudos to the ideas you like the best. The
more kudos your idea receives, the better the chance of it making it into the product. At the
Autodesk Inventor Idea Exchange, you can even track the status of ideas as they grow from initial
concept to ultimate release!
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Drawing

57) Raster views

A new option in the drawing view dialog box creates raster views that do not become precise over
time. You control when to make the views precise.

Raster views can help you defer the cost of precise drawing view recompute when you edit a large
model. For example, open the drawing document and convert all views to raster. Open the assembly
file and edit the model. The drawing document displays the changes without waiting for a full
recompute.

A raster view displays in the browser with a diagonal red line through it. Green brackets frame a
raster view in the display.

Use the browser context menu to convert an individual view to a precise or raster view. Use the
context menu in the display and select Make All Views Precise, or Make All Views Raster to convert
multiple views.
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58) Import Hatch Patterns

You can load hatch patterns from an external PAT file to add custom hatch patterns to your
drawings. To do this, edit a hatch and select other from the Pattern list, and then click Load. You can
also do this in the Style and Standard Editor to add custom hatches to your company standard.

59) Dimensions in Isometric Views

Isometric dimensions are functionally identical to orthographic dimensions; however, they cannot
be “moved.” That is, they cannot be detached and reattached to different geometry, and they can’t
be moved using the dimension Move option on the dimension’s context menu. All formatting
options and behavior are otherwise identical. Although placing isometric dimensions may seem
unconventional, you can, in fact, often eliminate the number of views required to concisely
communicate the design by placing dimensions on an isometric view.

A quick way to place dimensions on an isometric view is to right-click the view and choose Retrieve
Dimensions.

...
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Isometric Dimensions
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60) Do you need to use Content Center (Content Center)

Many people find the file structure of Content Center—generated files to be at odds with the way
they store purchased and standard parts. If you find this is the case with your setup, you might
want to use Content Center to generate parts but then save copies of them under your own file
structure as needed. Often, commonly used components are generated from Content Center in
this manner and then placed in a company’s purchase part directory after the Part Number and
Description iProperties are adjusted.

61) Adding a New Category to Content Center (Content Center)

If you need a unique category for your own specific parts, you can simply add a new family of parts
instead of using an existing category. You can do this from the Content Center Editor (accessed from
the Manage tab). Make sure the library view is set to view only the read/write library in which you
intend to create the new category and that the tree view is enabled. Then right-click in the blank
space in the Category View pane, and choose Create Category. You can also create a subcategory by
right-clicking an existing category and selecting Create Category.

Content Center Editor...
Yiew Edit Tools Help

007 (Y- B A B

Libirary Yiew: .@Mastering Inventar

X
#-fm Fasteners
#-(F) Other Parts
[+ Sheet Metal
4 Searchresults

451 Hiskory

: __| Create Category...

Adding to Content Center
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Reference:

Video Learning & Book

1)
2)

Blogs

1)
2)
3)
4)
5)
6)
7)
8)
9)

Autodesk Inventor 2014 Video Learning Content - www.trainingtutorial.com
Mastering Autodesk Inventor 2014 (book) - http://goo.gl/VEAdvw

Inventor Tales > http://www.inventortales.com
CADSetterOut > http://cadsetterout.com

John Evans Design > http://www. http://designandmotion.net

Imaginit (Mark Flayler) > http://blogs.rand.com/manufacturing/mark-flayler.html

Autodesk MFG Northern Europe > http://autodeskmfg.blogspot.com

Inventor Trenches > http://inventortrenches.blogspot.com

Autodesk Mfg Blog Rolls > http://autodeskmfg.typepad.com/blog/blog-roll.html

Inventor Topix > http://inventortopix.blogspot.com
Wiki help > http://help.autodesk.com
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